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LEGAL NOTICES

THIS DOCUMENT CONTAINS CONFIDENTIAL AND TRADE
SECRET INFORMATION OF FOCUS ENHANCEMENTS AND
ITS RECEIPT OR POSSESSION DOES NOT CONVEY ANY
RIGHTS TO REPRODUCE OR DISCLOSE ITS CONTENTS, OR
TO MANUFACTURE, USE, OR SELL ANYTHING THAT IT
MAY DESCRIBE. USE IN WHOLE OR IN PART WITHOUT THE
SPECIFIC WRITTEN AUTHORIZATION OF FOCUS
ENHANCEMENTS IS STRICTLY FORBIDDEN.

EVERY EFFORT HAS BEEN MADE TO ENSURE THAT THE
INFORMATION IN THIS DOCUMENT IS COMPLETE AND
ACCURATE AT THE TIME OF PRINTING; HOWEVER, THE
INFORMATION CONTAINED IN THIS DOCUMENT IS
SUBJECT TO CHANGE.

Copyright 2007 Focus Enhancements
All Rights Reserved

The material contained in this document is also protected by
copyright laws of the United States of America and other
countries. It may not be reproduced or distributed in any form by
any means, altered in any fashion, or stored in a data base or
retrieval system, without express written permission of FOCUS
ENHANCEMENTS.

FOCUS ENHANCEMENTS cannot be responsible for
unauthorized use of equipment and will not make allowance or
credit for unauthorized use or access.
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Contacting FOCUS ENHANCEMENTS:

USA
Office Hours:

Email:
Telephone:
Fax:
Address:

Monday through Friday
8:00 AM to 5:00PM (Central Time)

support@focusinfo.com
+1 763-398-1658
+1 763-571-7688

Focus Enhancements, Inc.
1370 Dell Avenue
Campbell, CA. 95008
www.focusinfo.com

EMEA (Europe, Middle East, Africa)

Office Hours:

Email:
Telephone:
Fax:
Address:

Monday through Friday
9:00 AM to 5:00PM

techsupport@como.com
+49 4307 - 83 58 58
+49 4307 - 83 58 99

COMO Computer & Motion GmbHA
A Focus Enhancements Company
Lise-Meitner-Str. 15

24223 Raisdorf / Germany
www.focusinfo.com
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Regulations and Safety

Focus Enhancements, Inc.
1370 Dell Avenue
Campbell, CA. 95008

Model Number: FS-C

Date of Manufacture:
Reference the Serial Number label attached to
the unit.

Serial Number

The serial number for this equipment is located on the back of the
unit. Please write this serial number on the enclosed warranty
card and keep it in a secure area.

FCC Class B

This product satisfies FCC regulations when shielded cables and
connectors are used to connect the unit to other equipment. To
prevent electromagnetic interference with electric appliances
such as radios and televisions, use shielded cables and
connectors.

This equipment has been tested and found to comply within the
limits for a Class B digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio
communications. However, there is no guarantee that
interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off
and on, correct the interference by one or more of the following:

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

* Connect the equipment to an outlet on a circuit different
from that used by the receiver.

* Consult the dealer or an experienced radio/TV technician
for help.
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Symbol Used In the FS-C Unit
j This symbol indicates the presence of an uninsulated

Dangerous Voltage within the product’s enclosure
that may constitute a risk of electric shock to persons.

Symbols Used in This Documentation

A This symbol indicates important information that the User
should read.

@Note

This symbol indicates supplementary information about
features, functions, or operations that may be of interest to
the user.

Documentation
Read, Retain, and Follow Instructions

All the safety and operating instructions should be read before
the product is operated.

* Retain Documentation
Place documentation in a secure place for future reference
on operating and safety instructions.

* Follow All Operating and Safety Instructions

* Pay Attention to All Warnings
Warnings are provided to protect the operator, the
equipment, and content.
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Electrical Precautions
Do Not Expose to Moisture

Do not use this product near water or in an environment where it
is exposed to dampness or there is the possibility of it getting
wet.

Do Not Remove Cover

There are No User Serviceable Parts inside this unit. Servicing
should be done by qualified service personnel.

ON / OFF Switch in Stand-By Position

The On/Off switch Does Not Separate the Unit From the Main
Power when it is in the stand-by position.

Power Sources

Use only power sources that match those indicated on the
marking label. If unsure sure of the type of power supply that is
available, consult your dealer or local power company.

Do Not Overload Power Outlets

Do not overload wall outlets, extension cords, or integral
convenience receptacles as this can result in a risk of fire or
electric shock.

Verify Power Plugs are Fully Inserted

To prevent potential electrical shock to personnel, verify that the
FS-C power cord plug is fully inserted in to a grounded receptor
and that the plug blades are not exposed.

ATTENTION

POUR PREVENIR LES CHOCS ELECTRIQUES NE PAS
UTILISER CETTE FICHE POLARISEE AVEC UN
PROLONGATEUR, UNE PRISE DE COURANT OU UNE
AUTRE SORTIE DE COURANT, SAUF SI LES LAMES
PEUVENT ETRE INSEREES A FOND SANS EN LAISSER
AUCUNE PARTIE A DECOUVERT.

Power-Cord Protection

* Routing Power-Cords
Route power supply cords so that they are not likely to be
walked on or pinched by items placed upon or against them.
Avoid sharp angles in the cord, particularly at plugs,
convenience receptacles, and the point where they exit the
product.
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* Non-Use Period
During extended periods when the device is not used,
unplug it from the power source and retract the power-cord.

Grounding or Polarization

* Polarized
If this product is equipped with a polarized alternating
current line plug (a plug having one blade wider than the
other), it will fit into the outlet only one way. This is a safety
feature. If you are unable to insert the plug fully into the
outlet, try reversing the plug. If the plug should still fail to
fit, contact your electrician to replace your obsolete outlet.
Do not defeat the safety purpose of the polarized plug.

* Grounded
If this product is equipped with a three-wire grounding type
plug, a plug having a third (grounding) pin, it will only fit
into a grounding type power outlet. This is a safety feature.
If you are unable to insert the plug into the outlet, contact
your electrician to replace your obsolete outlet. Do not
defeat the safety purpose of the grounding type plug.

Outdoor Antenna Grounding

Antenna

— Antenna Lead-in Wire

Grounding
Clamp

Ant Disch it
Electric Service ntenna Discharge Uni

Equipment
Grounding Conductors
Power Service Groundi

Electrode System Grounding Clamps

Figure A National Electric Code

If an outside antenna or cable system is connected to the FS-C,
verify that the antenna or cable system is grounded. This
provides some protection against voltage surges and built-up
static charges.

Refer to Article 810 of the National Electric Code, ANSI/NFPA
70, for information about the proper grounding of the mast and
supporting structure, grounding of the lead-in wire to an antenna
discharge unit, size of grounding connectors, location of antenna
discharge unit, connection to grounding electrodes, and
requirements for the grounding electrode.
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Lightning and Power Surges

During electrical storms or when left unattended and unused for
long periods of time, unplug the FS-C from the power source and
disconnect the antenna or cable system.

Power Lines

Do not locate an outside antenna system in the vicinity of
overhead power lines, electric light or power circuits, or where it
can fall onto such lines or circuits.

When installing an outside antenna system, extreme care should
be taken to keep from touching such power lines or circuits as
contact with them might be fatal.

Optical Precaution

The use of optical instruments with this device will increase
hazards to the eyes hazard.

Maintenance and Moving

Cleaning

Unplug this product from the wall outlet before cleaning. The
product should be cleaned only with a polishing cloth or a soft
dry cloth. Never clean with furniture wax, benzine, insecticides
or other volatile liquids since they may corrode the cabinet.

Servicing
Unplug the device from the power outlet and refer servicing to
qualified service personnel under the following conditions:
*  When the power-supply cord or plug is damaged.
* If liquid has been spilled, or objects have fallen into the
product.
* If the product has been exposed to rain or water.

* If the product does not operate normally when following the
operating instructions. Adjust only those controls that are
covered by the operating instructions. The incorrect
adjustment of other controls can result in damage and often
requires extensive work by a qualified technician to restore
the product to its normal operation.

* If the product has been dropped or damaged in any way.
*  When the product exhibits a distinct change in performance.
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Accessories and Replacement Parts

Use only attachments and accessories recommended by Focus
Enhancements.

Use only replacement parts specified by the Focus Enhancements
or of comparable quality and characteristics as the original parts.

Unauthorized substitution of parts can result in fire, electrical
shock, other hazards, and loss of warranty.

Safety Check

Upon completion of any service or repairs to this product, ask the
service technician to perform safety checks to determine that the
product is in proper operating condition.

Operating Environment
Location

Any mounting of this device should follow its instructions, and
should use only mounting accessories recommended by Focus
Enhancements.

* Install this device on a sturdy, level surface, away from
moisture and dust.

* Heat
Locate this device away from heat sources such as radiators,
heat registers, stoves or other electrical devices (including
amplifiers) that generate heat.

Ventilation

Do not block the ventilation openings in the FS-C body.
Overheating can occur and damage the device. Do not place this
device in a built-in installation, such as a bookcase or rack,
unless proper ventilation is provided.
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Introduction

Thank you for purchasing a Focus Enhancements’ FS-C portable
direct-to-edit (DTE) disk recorder. The FS-C is the first portable DV/
HD disk recorder with DTE technology designed for hand held
camcorders in a small, rugged and shock proof chassis.

If you edit with applications from Adobe, Apple, Avid,
Canopus, Matrox, Pinnacle, Sony, Ulead, and many others,
Focus Enhancements' DTE Technology is the only solution that
can save hundreds of hours a year by recording clips to disk in
your non-linear editor’s (NLE) native file format.

DTE Eliminates Pre-edit Processing

The FS-C DTE disk recorder eliminates the need to capture,
transfer or convert video clips before editing. The FS-C is a
stand-alone device that records DV25, HD 720p, and HD 1080i
video to its disk drive as a NLE native file. In HD Recorder
mode it has the capability of capturing to disk HD 720p and
1080i video from HDV camcorders equipped with a 1394
interface. For most DV and many HDV compatible NLE
systems, when the disk drive is connected to a computer the
clips are immediately available for editing. Shoot, connect, and
edit: it is now that easy.

These capabilities make the FS-C the perfect companion for the
Canon HDV camcorders.
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Unpacking

Verity that the FS-C has the following items:

1. FS-Cunit

2. Beltclip

3. User guide

4. Two Firewire cables

5. Power cord

6. Power supply with cable and connector to the FS-C
7. Removable Li-Ion battery pack

@Note

Missing or Damaged Components

If there are missing or damaged items, contact Focus Enhancements
Support for assistance.

USA Email: support@focusinfo.com

USA Telephone: +1 763-398-1658

EMEA Email: techsupport@como.com

EMEA Telephone: +49 4307 - 83 58 58
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Features

FS-C Features
The FS-C offers the following features:

« Tapeless acquisition

Especially equipped camcorders permit the use of
Direct To Edit (DTE) Technology to record directly
from a camcorder while shooting and without the need
of a tape.

 True DTE Technology

When shooting is finished, connect the FS-C to a
computer and instantly be ready to edit in the timeline.
Files are recorded to disk as

HD Recorder DV Recorder: DV Recorder
M2T AVI Type 1 (NTSC units):

AVI Type 2 AVI Type 2 24p
Avid OMF QuickTime 24p
Canopus AVI
Matrox AVI
Pinnacle
QuickTime
RawDV

FS-C provides support for cutting edge HDV
camcorders with 720p and 1080i MPEG-2 capabilities
and FireWire, 1394, connection.

» Fast and Efficient Editing

When shooting is finished, mount the FS-C to a Mac or
PC editing system like a typical FireWire hard disk
drive. Transfer clips to your NLE's media drive at up to
400 Mbps or edit instantly in real-time using the FS-C as
your media source. With some DV and HDV
compatible NLE systems, it is necessary to capture the
video footage using the NLE system’s capture
capability.

» Confidence in Recording

Now, simultaneously record to disk and tape while you
shoot, providing an immediately available, drop out
free, edit source with an archive and backup on tape.
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« Compact, Lightweight, Rugged Design

The FS-C weighs approximately one pound including
the battery and is only 1.5" thick. You can mount the FS-
C directly to your camcorder using the optional camera
mount kit, or clip the FS-C directly to your belt. The FS-
Cis designed to withstand the rigors of field shooting.
The programmable, 10-second electronic shock cache
ensures that your video is always recorded even in the
roughest of conditions.

» Flexible Capacities and Power
The FS-C is available with different capacity hard
drives. See the Focus Enhancements website for more
information, www.focusinfo.com.
Extend record times by linking two FS-C units together.
Power the FS-C using slim, removable battery packs or
power it using the supplied AC adapter.

» Easy to Use, Control and Update

The FS-C interfaces with your camcorder using a single
FireWire cable that passes audio, video, timecode and
control information. When a tape is present, each press
of start and stop on your camcorder's record button
creates an individual clip on disk. The FS-C features a
comprehensive backlit display, menu system and
buttons allowing easy control and management. In
addition, these units are upgradeable in the field.

 Never Miss A Shot

FS-C's ten second retro record mode means you are
always recording. When action happens, you know up
to ten seconds prior to the event occurring is saved in
your clip.

* Retro Disk and Loop Record modes.
* Scene Marking;:

This allows categorizing video clips into pre-named
folders on the disk during a shoot.

* User definable time lapse.
* Loop playback modes.

* Free Run, Rec Run, and Regen timecode modes.
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FS-C 2.0 upgrade features
*  QUICKTIME HD DTE format
* MXF OPatom DV DTE format.
« HD TC display and restripe capabilities.
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Quickstart

This section provides the following information necessary for using
the FS-C as quickly as possible.

Physical Description and Basic Controls................ccccvvveveeeen. 8
The FS-C Menu SYStEM .....cccovviiiiiiiiiieiieieeee e 16
Connecting the FS-C to AC POWEr .......ccoooiiiiiiiiiiiiiiieeeeenn. 20
Installing / Removing the Battery Pack .........ccccccccoevinnnnnnee. 21
Connecting a FS-C to a DV/HD Camcorder ........ccccceeeeeennn. 23
Record and Playback with the FS-C .......cccccccccoiiiiiiiniinne, 24
Power ONnthe FS-C ... 24
Select HDD Recorder MOde .........ccoovivvveeiiiiiieeeiiiiiee e 25
Select a DV/HD File FOrmat ...........cccccciieeainiiiiiiiiiiiiieeeeen 26
Set Time and Date ........ccccvviviiiiiieiiiice e 27
Record With the FS-C ... 29
Manual RECOIAING .....vuvrriiiiiiieeeeeiiisciiieir e e e 31
SYNCIO SIAVE ...ttt 32
TAPEIESS ooveeiee et ——————— 33
Playback on the FS-C ... 34
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Physical Description and Basic Controls

Front Panel Controls

¥
DTE recHnoLoGy

LCD
Display

Function
buttons
A B C &
Power ON —» ( Ejlt\{[gr?;lon
and Reset
Button Transport
Record 4— Control
Button ) | buttons
Power OFF \ Speaker
and
Stop button
LCD Display

This is a backlit, 14 character by 7 line dot matrix display.

In event of a mild electrical discharge to the unit the LCD could go blank. To
correct, hold the SELECT button down for 5 seconds.

Function buttons (A, B, C)

Below the FS-C LCD display are three user-defined
function buttons: A (left), B (center), and C (right). Use
them as short-cut keys for the most frequently selected
functions at the bottom of the LCD display. The function of
these soft buttons changes, depending on the options
displayed above that specific button. Refer to the Functions
Screen on page 76 for more information.
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Power On Button
The Power ON button provides two functions.

e Power ON
Turn on the FS-C.

* Reset FS-C
* FS-C first must be powered on.

¢ Hold down the Power On button for more than one
second.

* Power OFF
Hold down the OFF button ® for three (3) seconds.

During power off, the FS-C beeps, indicating that it is
turning off.

@Niote

Alarm OFF
If the Alarm feature is set to OFF, then the power-down sequence
occurs silently.

Navigation Buttons

Use these buttons to navigate through the FS-C menus. The
navigation buttons are Left, Right, Up, Down, and Select.

Transport Control Buttons
Play

Record

Back ——————p ) : s 1Forward
Search " Search

{
|
|

Back STOP Forward
Index Power Off Index

Use these buttons to control FS-C playback and record
functions. You usually operate these transport buttons
while on the Home screen.
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10

Record e

Press this button once when the FS-C is in Stop mode to put the
FS-C into REC-PAUSE. Press it again to start recording. Pressing
the Record button while recording, causes the current clip to
close and a new clip is created without dropping any frames.
This button is the only button that has a red legend on the front
panel.

Back Search €«

Press this button to play video at speeds different than real-time.
Refer to the note in the Forward Search section.

Play »
Press this button to start playback of the selected clip.

@iote

Some HDV Camcorders Require a Moment to Synchronize

Some HDV camcorders require a moment to synchronize the video from an
external source. Typically during this period, they display a solid blue or
black video until synchronized.

Forward Search »p
Press this button to play video at speeds different than real-time.

@iote

Fast Forward and Reverse
Pressing the Forward Search button multiple times results in increases in
the search speed, i.e. fast forward. This mode works both in forward and
reverse functions. For instance, if you are in 10X FF speed and you press
the Back Search button once, the FS-C is now in 2X FF mode. In addition,
this applies to backward search speeds. The default speed resolution is as
follows (NTSC and PAL have slightly different multiples for < 1X)

¢ Reverse: -30X, -10X, -2X, -1X (reverse play), -1/2X(-15fps), Still.

e Forward: Still, +1/2X (+15fps), +1X (play), +2X, +10X, +30X

Fast Forward and Reverse Search Compatible Camcorders
In Forward and Reverse Search modes, some camcorders do not display
video when played-back from an external device, such as the FS-C.
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Back Index |4«

This button returns the FS-C to the beginning of the current clip
when in playback mode. Press this button twice in sequence to
return the FS-C to the previous clip during playback. In STOP
mode, press this button to return the FS-C to the beginning of the
previous clip.

@Niote

Using Back Index with Short Clips
When using Back Index with short clips, it is first necessary to place the
FS-C in STOP mode.

Pause, STOP m and Power OFF

While in the Home screen, and in any transport mode, press this
button to Pause the FS-C. Press it again to stop the FS-C. Refer to
the section, Setup Screens on page 65 for more information.

To power off the FS-C, hold down the STOP button m for three
seconds. During Power OFF and if the Alarm function is ON, the
FS-C, makes an audible beep indicating it is turning off.

Forward Index »p|

Use this button to skip forward to the next clip in STOP and PLAY
modes.
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Top Panel
The top panel contains the following connectors and LEDs:

Camera

Remote Control (FireWire Connector)

(Serial Connector)

Computer
(FireWire Connector)

Status LED

Charge LED >

Charge LED States

LED Indicates
Off No Charger Connected
Green Charging Cycle Completed

Amber / Green Floating Charge Mode (Charging almost completed.)

Amber Fast Charge Mode (Maximum charging rate.)
Red Charging Error
Red / Amber No Battery Installed / Battery Error

Amber, flashing Insufficient Voltage to Charger

Status LED States

LED Indicates
Off Power OFF
Green Power ON (Power On but there is no activity.)

Orange, solid Playback

Orange, fluttering Hard drive being accessed during playback.
Red, solid Recording Mode

Red, blinking Recording Pause
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Computer FireWire Connector

* In/Out: 6-pin IEEE-1394a port x 1
* Asynchronous Data I/O

Remote Control, Serial Connector
e GPI/ RS232C; 3.5mm TRS mini jack. (3.5mm to DB-9
cable accessory available).
* Configure as a simple contact closure or RS-232C port.
* Connect an optional wired remote commander.

Camera FireWire Connector

* DV/I/O

*  6-pin IEEE-1394a connector

¢ Isochronous 25Mb/s DV video I/O
FS-C supports 1080i/720p video I/O when used with
HDV camcorders equipped with a 1394 connection like
the Canon HDV camcorders.

* DV Audio: embedded 2-channel (48kHz, 16-bit) or 2-
channel (12-bit, 32kHz) audio, 720p/1080i HDV MPEG1
Audio Layer II.

@Niote

4-Channel Audio
4-channel (12-bit, 32kHz) audio is available only with RawDV
format.

FireWire Alignment

IMPROPER INSERTION WILL DAMAGE UNIT

A Properly Align FireWire Cable and Connector - Do Not Force
Correctly align the FireWire cable to the connector before insertion. The
pointed end of the connector and the jack should be on the same side
before insertion:

Align pointed ends
of connector and
cable jack.
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Rear Panel

The rear panel contains the following important items:

Belt Clip Post

vent Compartment
Do Not Block Latch
- W Battery
Compartment
Side Panel

The side panel contains cooling vents as illustrated below.

Cooling Vents

Do Not Block
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Bottom Panel

The FS-C bottom panel features a single 2-pin DC power
connector. Connect the supplied AC power adapter here.

DC Internal
Power Speaker
Connector

—

Cooling Vent
Do Not Block

Internal Speaker
An internal speaker provides alarms and audible feedback.

To disable the audible feedback, go to the Settings menu
and select ALARM OFF. However, the power, temperature,
and disk capacity alarms are always active.
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The FS-C Menu System

The FS-C menu system provides access to all the functions
available in the unit. Each of the screens below (except the
Welcome and Home screens which come up automatically
when the unit starts) are accessed by pressing the Left or Right
navigation buttons. The functions of each of the selections on
these screens is explained in more detail in FS-C Functions on
page 49.

@iote

Returning to the Top of Menu or Home screen

To get to the top of any menu, press the Left button. To get back to the
Home screen:

« Highlight the screen title at the top of the screen.
* Press the Select button.

*+  Welcome
Only appears for several seconds upon power up.
* Home

Gateway screen for all functions, it displays disk and
operational status.

e Control

Contains the following selections:
* Local

* Syncro Slave

« AV/C

* Tapeless

 Play From

Provides lists to select play material from:
* Track List

* Reel List
 Play
Contains the following Play selections:
* Play Clip
* Loop Clip
* Loop All
*  Play All
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* Reels

Allows selected clips to be marked for placement in
particular Reels Folders.

e ROO
e RI11
e R22
e R33
e R44
e R55
e R66
e R77
e R88
e R99
e NONE
o Utilities

Contains the following disk and clip functions:
* Organize Reel
* Organize OMF
* Organize MXF 2.0 upgrade only
* Organize PINN
* Delete Clip
* Format
* Repair Disk
* Repair Clip bV mode only
* File Name
* Upgrade
* System Reset
* Diagnostic
* Status
* Functions

Contains user definable function button selections.
Changing a setting with a Function button is identical
to changing the setting in its corresponding menu.
Refer to Functions Screen on page 76 for more
information.
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18

Setup

Contains the controls for setting and reviewing the
FS-C configuration:

*  Set Date (MM/DD/YY)

¢ Set Time (XX:XX:XX)

* View Firmware Version

+ LCDLight ON

* LCDLight OFF

+ LCDLight AUTO

e Alarm ON

e Alarm OFF

* Stop Frame DV mode only

* Stop Gray DV mode only

* Stop No Video

¢ EXT CTL OFF

¢ EXT CTL PAUSE

e EXT CTL FRAME DV mode only

e EXT CTL FILE

* TCEXT (external)

e TCRECRUN DV mode or 2.0 only

e TCFREE RUN DV mode or 2.0 only

* TCREGEN (regenerate) DV mode or 2.0 only
¢ TCSET

e UBSET

e TC DROP NTSC only

e TC NON-DROP NTSC only

e HDV TC TYPE HD only in 2.0 upgrade
* LCD Contrast

HDD Mode

Contains the following hard drive selections:
* DV Recorder

* HD Recorder

¢ DD Drive

* Use Ext. FS-C
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e DV or HD Formats

Following HDD mode is a menu of formats available
for the type recorder selected in HDD mode.

When selecting DV Recorder the following formats are

shown:

e Raw DV

* AVITypel
e AVIType2

* Canopus AVI

* Matrox AVI

*  Quicktime

* Avid OMF

*  Quicktime 24p

* AVIType224p

* Pinnacle

When selecting HD Recorder the format displayed is:
e M2T

« Record

Contains the following recording functions:
* Normal

* Retro Disk

* Retro Cache

* Loop Record

e SNAP DV mode only

* Time Lapse DV mode only
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Powering the FS-C

* The FS-C operation without a battery installed.

To operate the FS-C without a battery installed, connect
the unit to an AC power source.

» Before operating the FS-C with battery power.

It is first necessary to fully charge the battery. An
uncharged battery, typically takes 2-3 hours to charge.

Connecting the FS-C to AC Power

Attach the AC power cord to the FS-C (with or without battery
installed). The FS-C is immediately ready for operation.

To do this, connect the AC power as follows:

Battery Pack

DC Cable

DC Power Port

1. Plug the cord from the power supply into the bottom of the
FS-C.

2. Connect the line cord to the rectangular power supply.

3. Plug the line cord into an electric outlet.
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Installing / Removing the Battery Pack

Installing a Battery

Battery Gently press DOWN
Latch Hook while sliding battery pack
FORWARD

Latch Slot
Latch \A\‘ |
-t by »

1.  Place the unit, so that the battery compartment is up.

Position the batterﬁ/ pack, as shown above, so that the latch
hook is almost in the latch slot, and touching the floor of the
battery compartment.

3.  Slide the battery forward while gently pressing down.
Feel the battery slide along guides and seat itself.
4. When seated, the battery latch clicks into place.

Removing a Battery

1.  Slide the battery latch to the left and hold.

2. Apply backward pressure to the batteri lI;ack at the
triangle/arrow and gently slide the pack back about 1cm or
3/8in.

This is the reverse motion of inserting the battery.
3. Remove the battery pack.
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Charging the Battery

The battery begins charging anytime it is connected to AC power
using the AC adapter supplied with the FS-C. The charge LED
lights when the FS-C is charging. For information on the charge
LED, refer to the subsection Top Panel on page 12.

Before the battery can be used it must charge until the battery
status LED indicates the unit is fully charged (green).

@Note

The Charge LED on the top of the FS-C lights to show the
battery is charging.

An uncharged battery takes 2-3 hours to charge with the
unit powered off.

The battery provided with the FS-C can supply power to
the unit for about 90 minutes while in continuous Record
or Playback mode.

An optional high capacity battery (BATT-0009-01) capable
of providing power for almost three hours of continuous
recording is available from Focus Enhancements.

Using FireWire to Charge FS-C

It is possible to charge the FS-C battery through the 1394 port on a
computer provided that the computer outputs at least 15V through the
port. To determine if this is possible, consult the computer’s
specifications.

Battery Use
A Misuse can cause property damage and/or bodily injury such as

burns if a conductive material such as jewelry, buttons, or beaded
chains touch exposed terminals. The conductive material may
complete an electrical circuit (short circuit) and become quite hot.
Exercise care in handling a charged battery, particularly when
placing it inside a pocket, purse, or other container with metal
objects.

f Warning: Do Not Use Unapproved Battery Chargers

Use of battery chargers not approved by Focus Enhancements
could cause the battery to catch fire or explode.

Use Only Original Focus Enhancements FS-BC Battery Chargers
There are four versions of the optional FS-BC battery charger for
use in various parts of the world.

ASYF-0940-01 USA

ASYF-0941-01 Europe

ASYF-0943-01  United Kingdom

ASYF-0944-01 Australia
These optional battery chargers are available from either your
local dealer or online at the Focus Enhancements web store,
www.focusinfo.com/sales/store.
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Connecting a FS-C to a DV/HD Camcorder

Before performing this procedure, make sure you have
installed and charged the battery, see Installing / Removing the
Battery Pack on page 21.

1. Connect the supplied Firewire cable to the “DV I/O” connector
on the top of the FS-C.

IEEE 1394 Cable
4-pin to 6-pin

2. Locate the FireWire/DV/iLink (or similar) connector on your
video camera. It is located in different Flaces depending upon the

brand of camera. If you are unclear of its location, consult your
video camera manual.

@iote

FS-C Supplied with 4-pin to 6-pin FireWire Cable
A 4-pin to 6-pin FireWire, 1394, cable is provided with the
FS-C.

FireWire Connector

The FireWire connector on the XL H1 is located on the back side of the
camera, above the XLR connectors. On the XHG1 and XHA1 cameras the
firewire connector is located on the back to the right of the battery
compartment.

For more information, refer to the Canon HDV camcorder’s documentation.

3. Connect the other end of the FireWire, 1394, cable to your video
camera.
4, Turn on the video camera.

5. Turn on the FS-C.

FS-C Portable DTE Recorder 23



Quickstart

Record and Playback with the FS-C

Before using the FS-C, set up the unit as outlined in the
following sections:

Power Onthe FS-C ... 24
Select HDD Recorder MOde ......cccoeeeeeieiiieieeieeiiiiiiieeceeeeiiii, 25
Select a DV/HD File Format ........cccoooeeiiiiiiiiiiiiieeeii, 26
Set TiIMme and DAte ....cccvvvvviiiiiiieeee e 27
Record Withthe FS-C ... 29
Manual RECOIAING .....uvviiiiieeeeeeiiiiiiiiiiie e e 31
SYNCIO SIAVE ..o 32
TAPEIESS ..ot ————————— 33
Playback onthe FS-C ... 34

The values set in these procedures are fixed and persist
through power cycles. To change them, repeat the steps
outlined above.

Power On the FS-C

1. Press the Power ON button for more than one second and release

it.

Power ON Play
(Reset)

Navigation

Buttons

OFF (STOP)
To power OFF,
hold down for 3-5 seconds.
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2. The Welcome screen appears and displays while the
The Home screen appears when the FS-C initializes.

FS-C

PORTABLE
DTE RECORDER

3. The Home screen appears when the FS-C first powers up. For
more details about this screen, Home Screen on page 51.

[ ] STOP 1-
COUNTER = i
00:00:14:02 -
DISK 1 168 min

REEL
TAPE DISP LOCK

Select HDD Recorder Mode
1. Press the Right navigation button two times until the HDD Mode
display appears.
HDD MODE

-DV RECORDER
| HD RECORDER

DD DRIVE
USE EXT FS-C

2. Use the Down navigation button to highlight the recorder mode,
either DV or HD.

3. Press the Select button on the navigation buttons.
4. Press the Left button to return to the menu title.
5. Press the Right button once and advance to the FORMAT screen.
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Select a DV/HD File Format

The formats displayed depend on the recorder mode selected
in the previous step, for example DV RECORDER results in the
following:

DV FORMATS
RAW DV

-AVI TYPE1
AVl TYPE2
CANOPUS AVI

1. Use the Up and Down navigation buttons to select the DV file
format that supports the preferred NLE system. A dash mark to
the left of a list item indicates that it is the current selection. The
default value is AVI Type 2.

@Niote

DV24p and PAL 25p Modes
24p modes are only for use with camcorder's that are capable of
DV-24p Advanced mode.

PAL 25p camcorders require no special 25p DV format

Check www.focusinfo.com for supported Applications

For a complete and up-to-date list of supported applications and
their associated formats, visit the website:
http://www.focusinfo.com

2. Press the center Select button on the navigation buttons.
3. Press the Left button to return to the menu title.

4. Press the Right button once and advance to the SETUP screen.
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Set Time and Date

@iote

Date and Time Must Be Set

The date and time must be set because they are used in the FS-C file
naming function.

1. Press the Right navigation button several times until the Setup
display appears on the screen as shown below:

SETUP

09/15/05
11:21:13

V 1.0.0
-LCDLIGHT ON

2. Use the Down navigation button to highlight the date and press
the Right navigation button to access the SET DATE screen.

SET DATE

)/ 15705
MM / DD / YY

BACK

3. Use the Up and Down navigation buttons to change the
highlighted value. Use the Right and Left navigation buttons to
highlight the Month, Day, and Year.

4. When complete, press the right-most Function button indicated
as BACK on the screen. The new date will be indicated on the
SETUP screen.
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5. Use the Down navigation button to select the time and press the

Right navigation button. The following screen appears:

SET TIME

Iﬂkm;13

HH: MM : SS

BACK

6. Use the Up and Down navigation buttons to change the

28

highlighted value. Use the Right and Left navigation buttons to
highlight the Hour, Minute, and Second. (Time is indicated in
24hr. mode.)

Press the right-most Function button indicated as BACK on the
screen. The new date appears on the SETUP screen.

The Time and Date are now set.

Press the Left navigation button followed by the Select button to
return to the beginning screen.

For more information on the Setup function, refer to the section,
Setup Screens on page 65.
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Record With the FS-C

There are four modes of recording with the FS-C.

e Manual Recording
Control with the FS-C transport buttons.

e Syncro Slave

Use this mode with camcorders that do not have FS-C
compatible external control or tapeless trigger
functionality. In this mode, the FS-C watches the record
status of the camcorder and replicates its actions. A
tape must be in the camcorder for this mode to
function.

e Tapeless

Control recording with other camcorders that have
FS-C compatible external control or tapeless trigger
capabilities. Use this control mode with companion
Canon camcorders, like the XLH1, XHG1, and XHAT.

Before beginning recording, verify that:

1. Time and date are set.

2. Recording format is set.

3. The FS-C is connected to the video camera according to
the explanation in Connecting a FS-C to a DV/HD Camcorder
on page 23.

4. Camera and FS-C are powered on.

5. Tape is loaded in the camera.

@iote

Tapeless Control

If the camcorder supports an external control function, then tapeless
recording is possible. Otherwise, the FS-C control panel keys must be
used to control recording in LOCAL control mode when there is no
tape in the camcorder.

For a list of compatible camcorders, go to Focus Enhancements
website at http://www.focusinfo.com.
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A Do Not Disconnect Power or FireWire Cable

Never disconnect the power or the FireWire cable during a
recording. This will cause file corruption.

Loss of Power During Recording

If power is lost during recording it is possible to repair the
damaged file or files, refer Repair Disk on page 86 to and
Repair Clip DV Mode only on page 87.

@Note

Troubleshooting: Counter Not Incrementing
If the Counter does not increment while recording from the camera, it
is an indication that there is no active connection between the FS-C
and the camera.

« Verify that the FS-C 1394 DV I/O and the camera connections are

secure. It may be necessary to unplug and then reconnect them.

When a good connection is made, the Counter increments and
recording starts.

Verify Record Mode Matches Source Video Content and Format

If in DV Recorder mode, HD content will not record properly. A NTSC
or PAL DV source records only on a matching NTSC or PAL unit.

Switch Camera to External Control Mode
To set your companion Canon camcorder to external control mode,
turn the SYSTEM>DV CONTROL menu to ON.

EXTERNAL Control Requires 5 Second Wait
When using EXTERNAL control, FS-C requires a 5 second wait period
between stopping and starting a recording.

HDV Recording with Tape

When recording with a tape in the camera, there may be small clips at
the beginning of the FS-C recording. This is normal.
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Manual Recording

1. Set the video camera to Camera or Cam mode.
2. Verify that an image appears in the viewfinder.

3. On the FS-C, press Record ® once.
This sets the FS-C to Record-Pause mode.

Record @ ——==—1—

Stop m (OFF)

4. On the FS-C, press Record ® button a second time. The FS-
C begins to record. The timecode value is displayed on the
screen.

5. Press Stop m (OFF) once to return the FS-C to
Record-Pause mode.

6. Press Record ® and the FS-C begins to record again on the
same clip.

7. Press Stop m (OFF) twice to stop the recording.
8. Press Record ® twice to begin recording a new clip.
Creating a New File without Dropping Frames

When in record mode, it is possible to break the recording into a
separate, new file without dropping frames.

Press Record ® and the FS-C automatically creates a new clip.
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Syncro Slave

CONTROL

LOCAL
-SYNCRO SLAVE
AV /C

TAPELESS

This mode is for camcorders that do not have external
control or the tapeless control functionality compatible
with the FS-C.

Syncro Slave mode requires that a tape be in the
camcorder for operation.

The FS-C must be set to Syncro Slave control mode.

In this mode, the FS-C watches the record state of the
camcorder and follows its actions.

When Synchro Slave mode is entered from the menu, the
Home screen appears with the Pause indicator displayed in
the upper left-hand corner along with a Y that indicates that
the FS-C is following the camcorder’s record state.

1.

Verify that the FS-C is in STOP mode.

From the FS-C Home screen, press the Right navigation
button several times until the CONTROL screen appears:

Use the Down navifation button to select Syncro Slave. The
dash on the left side of an item indicates it is the current
selection. The default value is Local.

Press the Select navigation button.

The beginning screen returns and a Pause indicator
appears in the upper left-hand corner. Next to this symbol,
is a Y indicating that FS-C is now following the record state
of the connected camcorder.

Now the FS-C will record at the same time the camcorder
records to tape.
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Tapeless

CONTROL

LOCAL
SYNCRO SLAVE
AV/C

-TAPELESS

Use the Tapeless control mode with camcorders that are
compatible with FS-C external control or tapeless operation
capabilities.

*  When the FS-C is in Tapeless mode, an E displays along

with the tape state, indicating that the unit is in Tapeless
mode.

e Use the camcorder’s REC button to Start and Stop the FS-
C tapeless recording.

* The camcorder’s Tapeless control or tapeless trigger
function must be enabled for this mode to work.

Refer to the camcorder User Manual for more details.

Recording Timecode in the File

Select EXT TC in the Setup menu. This option records the
video camera timecode in the file. There are other timecode
options available, refer to TIME CODE on page 70.

@iote

Function buttons

The tasks discussed above are available for programming into the function
buttons. For information on setting up function buttons, refer to the section,
Functions Screen on page 76
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Playback on the FS-C

Verify that both the video camera and the FS-C are powered on
and that they are connected together with the FireWire cable
from the FS-C DV/IO port to the camcorder 1394 port.

@iote

Feature Availability on PAL Cameras
This feature is not available on some PAL cameras.

1. Set the video camera to VTR or playback mode.

2. Navigate to the video clip to preview, using the FS-C Left and
Right transport control buttons.

Play

l Forward
Search

Back sommmem o— ) L —

|
|
|

Left Right
Transport Transport
(Back Index) (Forward Index)

3. Press the FS-C Play button.

4. Search through the clips using the FS-C Forward Search, Forward
Index, Backward Index, or Backward Search buttons. Refer to
Navigation Buttons on page 9 for more information on the
function of these buttons.

@iote

Camcorder Compatibility with External Players
Some HD camcorders are not compatible with the external player
functions Forward/Reverse Search and Pause.

VTR/CAMERA Setting
To change the VTR/CAMERA setting, use the dial on the left side of
the Canon HDV camcorder.
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Using with a Computer

Once video clips are recorded to the FS-C it is possible to use those
clips in most computer based DV/HD NLE systems. This section
contains the following:

INItIal SELUP oo 36
Mounting the FS-C in WINAOWS .........cccvviieiiiiiiiieeiiiiieeees 37
FS-C and FAT 32t 40
Using Avid OMF Clips (Required for DV mode only) ........... 41
Dismounting the FS-C (WINAOWS) .......ccceeveiiiiiiiiiieeeeeeeeeeee, 44
Mounting the FS-C (Macintosh) .........cccccceeeiiiiiiiiiiiiiineeee 45
Dismounting the FS-C (Macintosh) ...........cccccceeviiiiiiienenennn. 46

In the past, to get footage into an NLE system, it was necessary
to capture / digitize the footage using a video capture card. For
most DV and some HDV compatible NLE systems, FS-C DTE
functionality eliminates the capture stage. All that is necessary
is the moving of the video files from the FS-C to a computer.

@iote

Recording for Unsupported NLE

If a desired NLE is not supported by Focus Enhancements DTE, it is
necessary to use the AV/C control to capture the video footage for editing.
For more details refer to Control Screen on page 97.
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To move video files from the FS-C to a computer:

* Connect the FS-C’s Computer 1/0 1394 port directly to a
computer with an active OHCI compliant IEEE-1394
FireWire port and the necessary FireWire disk drive
drivers.

@Note

For More Information

Go to the FOCUS Enhancements' website (www.focusinfo.com) for
more compatibility information.

* Use the FS-C HDD Bypass mode, refer below for more
information.

The FS-C is compatible with any computer system that can
read FAT 32 volumes, such as Windows 98SE/ME/2000/XP
and Mac 0OS9/0S10.

Initial Setup

1. Connect the FS-C through its COMPUTER /0 1394 port to the
computer system using a standard 6-pin to 6-pin FireWire cable.

2. Enter HDD mode and enable DD Drive.
This step is required before mounting the FS-C to a computer.

* On the FS-C go to the HDD screen.
* Select DD Drive and Right arrow to Connect screen.
* Press Enable function button.
Refer to the section, HDD Mode Screen on page 60
3. Connect power to the drive if necessary.

4. Consult the computer’s documentation for more information.

36 FS-C Portable DTE Recorder



FS-C Using with a Computer

Mounting the FS-C in Windows
Use this procedure for Windows XP, 2000, 98SE and ME.

1. On a Windows-based computer system, double click the My
Computer icon on the top left hand corner of the desktop. A
directory window appears.

B [ few Fgeores ookt

D P Ry |-

2. Locate the FS-C drive and open it.
Often, it appears as a standard FireWire disk drive and may be
labeled E:, F:, G:, and so on.

3. Open the FS-C disk icon.

4. Open the folder with the most recent date code.

Be Edt Vew Favortess Took Hep L]
o © B Psech Brodes (300 X W @
Address [ Ei\ | B
Name ~ e Type Duate Modfied
=1 Fle Foider 7/14/2005 3:53 PM
a1 Fie Folder 7/14/2005 3:53 PM
a2 File Foider 7/14/2005 3:53 PM
(=] Fle Foider 7/14/2005 3:53 PM
a4 Fie Foider 7/14/2005 3:53 P
as File Foider /14/2005 3:53 PM
Qs Fle Foider 711472005 3:53 PM
a7 Fie Folder /1472005 3:53 PM
=t File Fokder /1412005 3:53 PM
as Fie Folder 7/14/2005 3:53 M
E320050803-164513-01 Fle Foider B/9/2005 12:40 PM
Qiog Fle Foider /22005 4:47 PM
Desktop 08 450 KB Fie 7/14/2005 3:53 PM
Desiktop DF 64K Fle /14/2005 3:53 PM
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This folder may contain several different files. The video clips.
can appear as:

B E:\20050803-164513-01

Be Edt Vew Favortes Took Help w
Qe - © - | Psencn 2 rones | (3 3 X )| @
Agress &3 E\20050803-164513-01 v Beo
20050803 164654-01.dv 20050809-123952-01
DV Fle MOV Fle
74,141 KB £3,104 KB

Iy 20050809-124027-01
| mov e

38,800 KB

e RawDV (.dv)
* AVITypel- (YYYYMMDDHHMMSSa01)

* AVIType 2 or AVI Type 2 24p -
YYYYMMDDHHMMSSb01)

* Canopus AVI - (YYYYMMDD-HHMMSSb01)

* Matrox AVI - (YYYYMMDD-HHMMSSmO01
This file has a separate .wav audio file per track.

* QuickTime or Quicktime 24p (.mov)

* Pinnacle - (YYYYMMDD-HHMMSSp01
There are two separate .wav audio files per track.

* Avid OMF (.omf)
OMF has two separate .aif audio files per track.

@Note

FS-C Video Clips in Reel Folder
FS-C permits the storing of video clips in either the standard
file folder or a Reel folder. If video clips have been assigned
to a Reel folder, it is necessary to run Organize Reels before
attaching the FS-C to a computer.
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HD Resolution and Frames

¢ M2T and MOV filename format:

FS-C Using with a Computer

YYYYMMDD-HHMMSSX01.m2t or .mov

where the X is a letter indicating the resolution of the
captured video file. The table below lists letters and
associated resolutions. Not all HDV camcorders support
these resolutions.

X
d

- ® @ O

N < o «Q

Resolution
720p, 23.976 fps *
720p, 24 fps *
720p, 25 fps
720p, 29.97 fps
720p, 30 fps
720p, 50 fps *
720p, 59.94 fps *
720p, 60 fps *
576p, 50 fps *
480p, 60 fps *

I @ mm>» O W O X

Resolution
1080i, 23.976 fps
1080i, 24 fps
1080i, 25 fps
1080i, 29.97 fps
1080i, 30 fps
1080i, 50 fps
1080i, 59.94 fps
1080i, 60 fps

* These resolutions are not supported in the HD RECORDER
QUICKTIME format. The unit will not record these resolutions
when the camera is in HD RECORDER QUICKTIME format.
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FS-C and FAT 32

The FAT32 tile system limits file size to a maximum of 2GB or
approximately, 9 minutes of recording time.

@Niote

Recording Time Depends on Recorder Mode and Resolution
The number of minutes per 2G file depends upon the recorder mode and
resolution:

¢ DV -9 minutes,

e 720p (MOV) - 10 minutes,
e 720p (M2T) - 13 minutes,
* 1080i (MOV) - 8 minutes,
e 1080i (M2T) - 9 minutes,

When clips exceed 2GB in size, the FS-C automatically creates a
new, file without dropping any frames. The two files have the
same root filename but have different two digit suffixes that
indicate the order of their creation, -01, -02, and so on. This

process can produce as many sequential 2GB files as the drive
can hold.

With most DV and many HDV compatible NLE systems on
Windows or Macintosh computers, it is possible to use clips
within the timeline. Select the clips on the source volume, i.e.
the connected FS-C, and import them directly into the NLE bin.

This makes clips immediately available in the NLE timeline.

The high transfer speed of the FS-C drive permits direct
streaming of the clips to the NLE, thus eliminating the need to
copy or transfer the clips before their use.
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Using Avid OMF Clips (Required for DV mode only)

These steps are required when using Avid OMF formatted
clips.

The Avid OMF file format was developed for use with Avid
editing products on Windows 2000, Windows XP or Mac 0SX.
These products include Avid Xpress Pro, NewsCutter, and
Media Composer Adrenaline (with the DV option).

The Avid OMF file format creates three files simultaneously;
one OMF video file and two separate AIF audio files. On the
computer's desktop, the files appear similar to those shown
below.

O _iolx
Fi= Edit Wew Faveiss Toos Heip I
vk = ) < (T [ sea | ke > )
-]
I 200 208 25- 1233060 Lol

3060 A 121 o

200 2063,
= 300 200,

B2 300 2063 2% 1 2 WA SR 1
=l Daskiop DB
= Daskicn bF

On the FS-C, the video file (OMF) and the audio files (AIF)
appear as one track.

When an Avid OMF file is deleted, the FS-C deletes the audio
and video portions at the same time.
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To use a FS-C recorded Avid OMF file on an Avid NLE system,
use the following procedure.

@Note

ORGANIZE OMF Function

If using the ORGANIZE OMF function on the FS-C before connecting it to a
computer, steps 2 and 3 are not necessary

Locate and open the FS-C drive folder.
Create a new folder and name it OMFI MediaFiles.
To do this in Windows, select File>New>Folder .

To do this with Macintosh, select File>New Folder. Next,
type OMFI MediaFiles.

5. Drag all the OMF and AIF files into the new folder:
Do Not Drag in the files titled Desktop DB or Desktop DF.

6. Launch Avid.

7. Open an existing project or create a new one.

LS

8.  Select Tools>MediaTool. A screen similar to the following

appears:
x
Vedm Orwe(s| Progects (s}
(5] +
T"ﬂ:l-t ]
b +
* - * -

= @ veser (s
@ . Frecengns (i
. MeamFies
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9. Locate and select the FS-C under Media Drive(s).

@Note

If Drive Does Not Appear

If the drive does not appear, check to make sure that the
OMFI MediaFiles folder was created correctly with proper
case and spacing.In addition, verify that the drive is properly
connected and recognized by the computer. Under
Project(s), select All Projects (This highlights all items in
the Project(s) window).

10. Verify that Master Clips is checked and press OK. The
Media Tools Window, similar to the following, appears:

o dierks Tosl alﬂl_ﬂ
e Tl e e

e Tty Tee ] Torwmmn Ol
T REER1ITRLL] Wikl SlabaETs S1AREAlT 19 4 ¥
B XN vald Diefsaw  nasgelr ETEH
O DEE-IDEEN] V1Al TI4T4EE ZIEM1m =ipas
| E—TTE | y=——— #[

11. Create a new bin (select File -> New Bin) or open an existing
bin in Avid.

12. Select all items in the Media Tools window (select Edit>
Select All).

13. Drag the contents of the Media Tools Window into the bin.
It is now possible to use these clips in the Avid timeline.
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Dismounting the FS-C (Windows)

When finished working with the FS-C and the computer, it is
necessary to dismount FS-C from the system

& Dismount FS-C Before Powering Off

It is important to dismount the FS-C from the Windows system
BEFORE powering down the unit.

To do dismount the FS-C:

1. Click the Safely Remove Hardware icon at the bottom right side of
the Windows task bar as shown below.

& U@  12:13PM

Unplug or Eject Hardware Icon J

(Safely Remove Hardware)

2. Next, the computer system prompts to remove the connected
FS-C. This begins the dismount process.

3. Select the message and click on it.

The computer dismounts the FS-C and then displays a message
that it is now safe to remove the unit.
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Mounting the FS-C (Macintosh)
1. Start the Mac computer and connect the FS-C’'s COMPUTER 1/O

port to the computer using a standard 6-pin to 6-pin FireWire
cable.

When mounted, the FS-C should appear on the computer's
desktop as shown below:

M = 4)) Fri8:56AM |

E

Macintosh HD

F5083004

The FS-C appears as a FAT32 volume with a PC label.
. Locate the FS-C on the desktop and open it up.

3. Open the folder with the most recent date code (for example,

FS-C Portable DTE Recorder

“20050127-110345-01"). It should look similar to the following;:

[ 20030831-072915-01

[ 20030831-072917-0L.mov
g Macintosh HD [@ 20030831-073322-0L.mov

Ergoggmm a [® 20030831-073457-01.mov
& 20030831-073505-01.mav

(I peskop [® 20030831-073508-01.mov
[ 20030831-073514-01.mov
& mattmcewen

# Applications
ﬁ Documents

ﬁ Movies
é Music

= Pictures
= ur e

6 items, 35.75 GE available

Before Connecting FS-C to a Computer
If clips have been assigned to a Reel folder: perform an Organize
Reels before connecting the unit to a computer.
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Dismounting the FS-C (Macintosh)

When finished working with the FS-C and the Macintosh it is
necessary to dismount the unit from the system.

A Dismount FS-C Before Powering Off

It is important to dismount the FS-C from the Mac system
BEFORE powering down the FS-C.

To dismount the FS-C from a Mac:

1. Select the FS-C on the computer's desktop. It is marked with a PC
symbol.

2. Drag the drive into the Trash or use the Eject button. This
dismounts the particular disk drive.

3. Itis now safe to remove the FS-C.

@Niote

Eject Shortcut for Two-button Mouse
If the Macintosh is equipped with a two-button mouse, the following shortcut is
available.

* Right-click the FS-100 icon on the desk top.

* Select the Eject function from the pop-up menu.
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Mounting Hardware

Mounting FS-C to a Camcorder

Mount the FS-C to your camcorder using the optional
Camcorder Mount Kit (P/N ASYF-0849-01). For more
information about this kit or to order it, contact Focus
Enhancements:

USA

Email: support@focusinfo.com
Telephone: +1 408 866 8300
Address: Focus Enhancements, Inc.

1370 Dell Avenue
Campbell, CA. 95008
www.focusinfo.com

EMEA (Europe, Middle East, Africa)

Email: techsupport@como.com
Telephone: +49 4307 - 83 58 58

Fax: +49 4307 - 83 58 99

Address: COMO Computer & Motion GmbHA

A Focus Enhancements Company
Lise-Meitner-Str. 15

24223 Raisdorf / Germany
www.focusinfo.com

FS-C Portable DTE Recorder
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FS-C Using with a Computer

Clipping to a Belt

Belt Mount Clip
Front View Side View

FS-C
Belt Clip Post

A belt mount clip is included with the FS-C. This mount is
similar to those used with cellular telephones. Attach the belt
mount to the belt clip post on the rear of the FS-C and push it
down to lock it in position. The belt clip can ratchet to various
positions when attached to a belt.
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This section contains information on the following LCD displays:

General Screen Information ..............ccccooviiiiiciccc 50
RECOId SCIrEENS ....vviiiiiiiiiiiiii e e e e 55
HDD MOOE SCIrEEN ....ccoiiiiiiiiiieeeerre e e ee e 60
FOrMAat SCrEEN .oiiieii i 63
HD FOrmat SCreen .......vviiiiiiiiiiieeceeiiii e 64
SELUP SCIEENS ...vvviiiiiiiiiee et 65
FUNCLIONS SCrEEN ..o 76
ULIHtIES SCrEEN .ovvviivie et 81
(OF0] 91 0] RS To (=1=T o R 97

FS-C screens are organized in a flat hierarchy. Every screen has
a unique name, and it is possible to cycle continuously through
the screens using the Left and Right navigation buttons.

Use the Up and Down navigation buttons to cycle through
screen items (selections).

Use the select Navigation button to make a choice.

@Niote

Navigation Tip: Jump to Top of Display Using the Left Button

When navigating through the LCD displays and scrolling down into the
menu, press the Left navigation button on the front panel and immediately
return to the top of the display, which allows navigating to other displays.
Jump to Home display Using Select Button

To return immediately to the Home Screen, navigate to the menu title at the
top of the screen and press the Select button.
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General Screen Information

The FS-C LCD displays are organized by function with each
screen displaying a list of items. An item can be:

¢ A value that can be set, such as the date.

¢ A switch similar to a check box, that can be enabled
along with other options in the display.

* A switch similar to a radio button, that belongs to a
family of options, in which only one can be active at
any time.

* Alink to another display, which is indicated by a p>.

SETUP Menu Title
Appears at the top of the
01/16/06 display and identifies its

topic or function.

09:30:19

V1.0.0
-LCDLIGHT ON

Navigation

Use the Left or Right Use the Up and Down
navigation buttons to move navigation buttons to move
to the previous or next between the items in the
display. display.

Welcome Screen

The Welcome screen appears briefly after boot-up, and
automatically switches to the Home screen when the FS-C is
ready for operation.

FS-C
PORTABLE
DTE RECORDER
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Home Screen

The Home screen is read only and has no navigable items. To
leave the Home screen use either the Left or Right Navigation

button.
1 2
*L‘
B STOP1- <=0 I 3
1 —I‘»COUNTER CIl g—

S

12— 00:00:14:02

i I
| DISK1 168 min <-— 6

10——= REEL
I TAPE DISP LOCK
7 8 9

Current Function: Symbol and Description

Refer to LCD Display Symbols and Text on page 99.
Volume Disk Number

The volume number is always 1 unless multiple FS-C’s are
connected, refer to USE EXT FS-C on page 61.

Clip Number

Number of the current video clip, i.e. 001 for clip 1.
The system can hold a maximum number of 999 clips.
Battery Life Gauge

This gauge is accurate only when the unit is powered
exclusively from the battery.

Timecode Value

Either Drop Frame - 00;00;00;00 or, Non Drop Frame -
00:00:00:00.

Time remaining on the disk.

FA Functions with TAPE as the default, refer to Functions
Screen on page 76 for more information.

FB Functions with DISP as the default, refer to Functions
Screen on page 76 for more information.

FC Functions with LOCK as the default, refer to Functions
Screen on page 76 for more information.
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52

10. Reel Display
In Record or Playback modes, this item displays the particular
REEL that a clip is located in or, has been marked to. If in
PLAY FROM > REEL LIST mode, the REEL appears in
brackets for example, [REEL]. This area is blank if NO REEL
has been selected.

11. DISP information field that displays data type.

12. DISP information field that displays current data.

DISP (display) Information Fields

Use the DISP function button to display current operation
information fields 11 and 12. The data shown depends on
the mode of operation, i.e. DV or HD Recorder.

Pressing the DISP button advances the display to the next
category of information. Below is a table of the data types
and data available with DISP.

Field
Number

11
12

11
12

11
12

11

Data Type /
Data Description

COUNTER

Shows frame count of current video clip during record or
playback.

REMAINING

Record: counts down number of available frames
remaining, as time, on a specific disk.
Playback: displays time remaining of the current clip.

DV (NTSC or PAL) or HD (see note following table)

The type of timecode displayed in HD RECORDER
mode from this screen is defined by the HDV TC TYPE
setting. See HDV TC TYPE page 74.

Record: displays the external timecode value being
generated by a camcorder or other device during a
recording session. Timecode mode must be set to EXT
TC for this function to operate, refer to TIME CODE
EXT, REC RUN, FREE RUN, REGEN on page 70.
Playback: displays the embedded DV timecode value in
a particular track.

UB NTSC

FS-C Portable DTE Recorder



FS-C Functions

12 Displays the set user bit value in a particular clip. A user
bit value must be added for this to display, refer to UB
SET on page 72.

11 ABSOLUTE

12 Displays an absolute timecode value for the particular
session: the sum of all COUNTER timecodes on
connected volumes.

Absolute is primarily used when setting the FS-C to AV/
C mode and controlling it with an external FireWire
device, such as a computer.

Qiote

DV (NTSC or PAL) and HD

The information displayed in fields 11 and 12 depends, in part, on which
Recorder Mode is set.

DV RECORDER

Line 11 displays the Standard Definition (SD) video format. It can not be
changed.

HD RECORDER

Line 11 displays the HD resolution of the current track which depends on
the camcorder in use with the FS-C HD unit. Possible values are:

« 1080/50i TC
« 1080/60i TC
« 1080/30F
. 1080/24F
. 1080/25F
.« 720/60 TC
.« 720/50 TC
« 720/30p TC
. 720/25p TC
. 720/24p TC
.« 576/50p TC

» 480/60p TC
Refer to the camcorder manual for supported resolutions.
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FS-C System Information Screens

The FS-C automatically creates information screens to indicate
conditions such as high temperature, power remaining, or
drive capacity remaining.

WARNING

5%
POWER
REMAINING

OK

Press OK to clear the screen and return to the last screen.
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Record Screens

NORMAL
-RETRO DISK

RETRO CACHE
LOOP RECORD

The Record screen permits setting the FS-C to various
recording modes, depending on the model:

« NORMAL

« RETRO DISK

« RETRO CACHE

e LOOP RECORD

¢ SNAP DV modes only

e TIME LAPSE DV modes only

Once a record mode is selected, the recorder remains in that
mode until a different mode is chosen. Exiting the Record
screen and returning to Home, enables the selected recording
mode.

To verify that the digital recorder is set to the correct recording
mode, refer to the upper left-hand of the Home screen where
the recorder mode is displayed.

Record Mode Indicator
(Retro Cache)

Symbol Indicates
L Retro Disk
C Retro Cache
(0] Loop Record

FS-C Portable DTE Recorder 55



FS-C Functions

Symbol Indicates
SNAP Snap Record
T Time Lapse

For more about LCD display symbols and text, see LCD Display
Symbols and Text on page 99.

Normal Record

This is the standard recording mode.
e All control is from the FS-C front panel.
Initially, the Home screen displays ® STOP.

* Pressing Record @ puts the FS-C into Il REC PAUSE
mode.

* Pressing Record @ a second time puts the FS-C into REC
mode.

Retro Cache Record Mode

:SS <&————This lineis not active:
reference only.

The Retro Cache mode insures that important material at the
very start of a recording session is captured. Retro Cache stores
in the on board memory a continuous loop of video captured
by video camera during pauses. Pressing Record @ begins
active recording at the last frame stored in the cache. The
resulting video clip has the cached video at the beginning.

Retro Cache is available in Local, Syncro Slave, and Tapeless
control modes.

Set the length of video that the Retro Cache should store: 0 to
10 seconds.
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Retro Disk Record Mode

HDD AVAIL;
176 min

RETRO TIME:

010 min -4—— 5 Thisistheonly
editable line on screen.

The Retro Disk mode records video in a continuous loop to a
user-defined portion of disk space. Pressing Record e
seamlessly begins active recording. The Retro Disk session is
appended to the beginning of the new clip. The result is a set of
clips beginning with the cached video and continuing with the
newly recorded video.

When calculating the amount of hard disk space

needed for a Retro Disk record session, always include

additional space beyond the recording requirements.

The added space depends on the length of the loop.

* Loops less than 60 minutes, need an additional 1 minute
of unused disk space.

* Loops 60 minutes and greater, require an additional 2GB
of unused disk space.

When looping less than one hour, Retro Disk records

the loop in a series of 1 minute clips.

Retro Disk is available in Local, Syncro Slave and Tapeless
control modes.

When Retro Disk is set, the symbols eL (Record and L)
appear in the FS-C display.
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Loop Record
Loop Record is similar to Retro Disk.

Loop Record continuously records a series of video clips to
available disk space. When all available disk space is used,
Loop Record begins sequentially replacing the earliest clip
with the most recent.

* The size of the video clip depends on the length of the

loop.
* Loops of 60 minutes or less are recorded in one-minute
clips.

* Loops greater than 60 minutes, are recorded in 2GB clips.

*  When the capacity of the disk is reached, one additional
clip is created. The size of the last clip depends on the
length of the loop i.e., one-minute or 2GB. The disk must
have at least 30 minutes of disk space available for this
functionality.

Saving Loop Record Clips
Press STOP during a record session.

The FS-C stops recording and saves the current LOOP RECORD
session clips to a folder on the disk.

Snap Record DV modes only

Use Snap to record individual frames. In Snap mode, pressing
Record e captures individual frames. All the frames recorded
in the same session are stored in a single file.

* To start a new SNAP record session, place the unit in
STOP between SNAP records.

* Snap Record is available only in DV modes of
operation.

* Use Snap in Local, Syncro Slave, and Tapeless control
modes.

* Removing power from the FS-C in the midst of a Snap
recording session causes the unit to return to Normal
recording mode when it powers back up.
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@Note

Another Method to Capture Single Frames
An alternative to Snap is EXT CTL FRAME. For more information see
EXT CTL OFF, Pause, Frame, File on page 69.

Time Lapse Record DV modes only

00:00:00:00

HH:MM:SS:FF <&—3—This line is not active:
reference only.

Time lapse provides the ability to record a single frame at
specific time intervals, for example one frame per minute,
00:01:00:00. Time lapse applications can include capturing the
traffic on city streets, the growth of a plant from seed to
maturity, and construction projects.

Features of the Time Lapse function include:
* All the captured frames are recorded in a single clip.

* The time between recording periods can be set in
frames, seconds, minutes, and hours.

¢ The maximum time between recorded frames is 24
hours.
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HDD Mode Screen

-DV RECORDER
HD RECORDER

DD DRIVE
USE EXT FS-C

This screen displays the following items:

60

@Note

DV RECORDER
This sets the FS-C as a DV recorder.

Connect the camera to the FS-C DV I/O port using a
FireWire cable.

HD RECORDER

This sets the FS-C as an HD recorder.

Connect the camera to the FS-C DV I/O port using a
FireWire cable.

Recording in this mode only works with HDV
camcorders that have a 1394 FireWire connector and
that support an HD resolution, such as 1080i or 720p.

Switching Between Recorder Modes (DV and HD)
Switching between recorder modes resets the RECORDER mode to
Normal, see Normal Record on page 56.

Power-cycle After Changing Recorder Modes

It is recommended that the FS-C be power-cycled after switching
RECORDER modes.

DD DRIVE p

Use this option when connecting the FS-C to a
computer. The FS-C functions as a volume visible to the
computer. In addition, this setting permits the
connecting of multiple

FS-Cs together to increase recording space.
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» USE EXTFS-C

Use this option when longer recording times are
needed. USE EXT FS-C permits the connecting of two FS-
C together to provide more disk storage for longer
recording. One unit acts as the master with the other as
a slave: the master records to itself until full and then
continues recording on the slave unit.

@Niote

Identifying Master/Slave Volumes During Record/Playback

When two FS-Cs are in combined via USE EXT FS-C and in either
Record or Playback mode, the volume on the Home screen will
display 1-xxx when the master unit is recording or playing back and 2-
xx if it is the slave.

FS-C Portable DTE Recorder 61



FS-C Functions

Setting Up Master and Slave FS-C

Master FS-C Slave FS-C

DTE recinotoey
STOP 1 - 001 CONNECT
COUNTER COMPUTER THEN
00:00: 00: 00 ENABLE BYPASS

DISK 1 000min ! SUCCESS
TAPE DISP LOCK EXIT

62

. Connect the camcorder to the master FS-C, DV 1/0 connector

using the supplied FireWire cable.

Master

Power on unit.

Go to the HDD Mode menu screen and enable
USE EXT FS-C.

Connect the FS-Cs through the units Computer 1/O connectors
using a 6-pin to 6-pin FireWire cable.

Slave
Power on the unit
Go to the HDD Mode screen and enable DD DRIVE.

Master
Begin recording or playback using the master FS-C.

A Use DD Drive Mode when Connecting to a PC

It is important to take the master FS-C out of USE EXT FS-C
mode before attempting to connect to a computer.

To do this, select DD DRIVE from the HDD Mode screen.
This returns use of the unit to hard disk mode.
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Format Screen

DV Formats

AVITYPE 1

AVI TYPE 2
CANOPUS AVI

DV formats include:

+  RAWDV

« AVITYPE1

« AVITYPE?2

«  CANOPUS AVI

+  MATROX AVI

«  QUICKTIME

« AVID OMF

«  QUICKTIME 24P (NTSC only)
«  AVITYPE 2 24P (NTSC only)

e PINNACLE
¢ MXF OPAtom FS-C 2.0 upgrade only
@iote

Using Organize

AVID OMF, MXF OPAtom (2.0 only) and PINNACLE formats require using
the Utilities functions, Organize OMF, Organize MXF, or Organize PINN
respectively. Refer to the section, Utilities Screen on page 81.

Formats for 25P Applications
Use standard file formats for all 25P applications except AVID OMF. OMF is
not compatible with 25P DV streams.

The latest DTE supported applications and file formats are
listed on the Focus Enhancements website:
www.focusinfo.com.
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HD Format Screen

The FS-C 2.0 upgrade provides the additional HD DTE format
QUICKTIME

The latest DTE supported applications and file formats are
listed on the Focus Enhancements website:
www .focusinfo.com.

Check regularly for updates.
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Setup Screens

10/10/05
21:10: 50

vV 2.0.0
-LCDLIGHT ON

The items on the Setup Screen are grouped by function. Within
the function the items act like radio buttons, i.e. when one is
active the others are not.

In some cases, such as the Date, a settings screen appears. To
return from a settings screen, use the BACK function button.

The items displayed on the Setup screen include:

DATE Displayed P
TIME Displayed P
VERSION Displayed p»

LCDLIGHT ON Group Default
LCDLIGHT OFF
LCDLIGHT AUTO

ALARM ON Group Default
ALARM OFF

STOP FRAME; (1st frame of current clip) DV mode only
STOP GRAY DV mode only
STOP NO VIDEO Group Default

EXT CTL OFF Group Default
EXT CTL PAUSE
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@Note

Date

66

EXT CTL FRAME
EXT CTL FILE

TC EXT Group Default

TC REC RUN DV mode or 2.0 only
TC FREE RUN DV mode or 2.0 only
TC REGEN DV mode or 2.0 only

TCSET p
UB SET p

TC DROP NTSC only
TC NON-DROP Default, NTSC only

HDV TC TYPE HD mode (2.0 upgrade only)

LCD CONTRAST

Date and Time Must Be Set
The date and time must be set. They are used in the FS-C file naming function.
Refer to Set Time and Date on page 27.

SET DATE
09 /18 /05

MM /DD/YY

BACK
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Time
SET TIME
10 : 50 : 40
Version
2.0.0.01010106
NTSC
This screen displays:

e FS-C Firmware version
¢ SD video of the unit.
¢ FS-C model
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LCD Light On, Off, Auto

These items enable or disable the LCD's backlight.
e LCDLIGHT ON Group Default
keeps the backlight on permanently.
* LCDLIGHT OFF
Keeps the backlight off permanently.
* LCDLIGHT AUTO

Turns off the backlight after one minute, pressing any
button pad button turns the backlight back on.

Any information screen turns the backlight on.

Alarm On, Off

Default is On.

*  When the alarm is enabled, pressing any button on the
FS-C produces audio feedback.

* The FS-C alarm triggers when conditions such as low
battery charge, low disk space, or over heating occur.

¢  When Alarm is set to Off, the audio feedback for the
buttons is disabled, however the alarm will still sound
for low power, high heat, or low disk space conditions.

Stop Frame, Gray, No video

These settings determine the FS-C video output when using
the search index keys to view recorded clips..

e STOP FRAME DV only
Displays the first frame of the clip.

e STOP GRAY DV only
Displays a black frame.

e STOP NO VIDEO Group Default
Video output is Off.
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EXT CTL OFF, Pause, Frame, File

These options permit the use of an external device to control
the FS-C through the optional RS-232 cable.

@Note

RS-232 Cable Available from Focus Online Store

The RS-232 cable required to connect the FS-C to an external control device
is Focus part number CBLA-0113-01. It and other accessories mentioned in
this manual are available at https://www.focusinfo.com/sales/store.

- EXTCTL OFF
Use this option when connecting an external device
using an RS232C cable.
* This requires the use of a a 3.5mm-to-DB9 adapter cable,
plugged into FS-C Control port.
In Local mode, select this item to control the FS-C with
the optional wired remote control unit.

The following options permit control functions to occur from a
simple contact closure.

« EXTCTL PAUSE
Controls Pause and Resume during a record or playback
session.

» EXT CTL FRAME DV Mode Only
Captures a single frame of video and records it to a file.
Each time this function is triggered, it sequentially adds
another frame to the same file until stopped.

« EXTCTLFILE
Creates a new file during a record session without
losing frames.
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TIME CODE EXT, REC RUN, FREE RUN, REGEN

The FS-C 2.0 upgrade provides additional TC REC RUN, TC FREE
RUN, and TC REGEN functionality in HD RECORDER mode.
This functionality is only active when HD FORMAT is set to
QUICKTIME. In M2T mode, all TC modes act as TC EXT.

The following are timecode (TC) functions.

@Note

70

TC EXT Group Default

Records the incoming source timecode. If the timecode
is not running, the FS-C records the same timecode
number in each recorded frame. Choose TC EXT mode to
clear any stored number.

TC REC RUN DV mode only

In this mode, after a power cycle, the FS-C starts its TC record
count using the TC SET value. Later recordings add to the last
value recorded. A power cycle resets the TC record value to
the TC SET value.

TC FREE RUN DV mode only
This function causes the FS-C to begin counting from
the value stored by TC SET.

* A number entered through TC SET is not stored and
available to the FS-C until exiting TC SET. Only then does
the FS-C begin counting using that number.

TC REGEN DV mode only

When the FS-C powers up in TC REGEN mode, it:

¢ Reads the timecode of the last track recorded.

¢ Adds1 to the number.

* Stores the new timecode as the number that will be
assigned to the first frame of the next recording session.

If the drive is empty, i.e. no existing recordings,
the FS-C uses the TC SET value.

TC SET and UB SET Can Be Set at the Same Time
Both parameters, TC SET and UB SET, may be set and are not mutually
exclusive as in some groups, i.e. LCDLIGHT.
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TC SET

TC SET

00 : 00:00: 00
HH: MM : SS: FF

The Timecode Set parameter stores a user defined timecode in
the
FS-C’s non-volatile memory. This value is available for use by
the FS-C immediately after exiting TC SET.

+ TCFREERUN

The FS-C uses this value on the next recording after it is
set in TC SET.

* TCREGEN

This is the starting value when using an empty hard
disk drive for recording.

* TCRECRUN

This is the value used to begin every recording session
after a power cycle.

@note

The TC SET value is only actively applied when the unit is in
DV RECORDER mode.
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UB SET

UB SET
FF:FF:FF:FF

The User Bit Set function provides the ability to change the
user bits in the timecode recorded in the video files.

¢ Timecode values are not set when in TC EXT mode.

Professional applications employ user bits to add metadata to
recordings to assist in post production. For example, multiple
cameras are used during a shoot. Each FS-C has a unique UB
setting that identifies it and the camera it serves. Later, the user
bits are used to determine from which camera station the
footage was recorded.

@iote

The UB SET value is only actively applied when the unitis in
DV RECORDER mode.
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TC DROP, NON-DROP NTSC only

These parameters are only available for NTSC and only one
may be enabled at a time. Drop and non-drop enable and
disable the drop-frame function that modifies how the
timecode is calculated during recording. These options are
only applied when the unit is in DV RECORDER mode.

« TCDROP

Enables the drop-frame function:

*  Frames 00 and 01 are dropped from each minute of video
recorded.

* Exception The first minute of each hour is not dropped.
e TC NON-DROP Group Default

Disables drop-frame. No frames are dropped during
recording and the timecode reflects the actual time
during recording.

@iote

Use with TC FREE RUN or TC REGEN

TC DROP and TC NON-DROP may only be set when using the TC FREE
RUN or TC REGEN settings.

Displayed Timecode Indicates TC DROP/NON-DROP Mode
The timecode displayed on the LCD indicates the TC DROP/NON-DROP
mode by using either a semi-colon or a colon as a separator between hours,
minutes, seconds and frames:

DROP HH;MM;SS;FF

NON-DROP HH:MM:SS:FF
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HDV TC TYPE Fs-C 2.0 upgrade only

HDV TC TYPE

-TTC
GOP TC

REC TC
PTS

This menu sets the source of the timecode displayed in the TC
DISP mode, while in HD RECORDER mode. This is also the
timecode reported in AV/C control mode.

e T7C (Title Timecode)

* GOP TC (Group of Pictures Timecode)

* REC TC (Recorded Timecode)

* PTS (Presentation Timestamp)
Each NLE utilizes a different HDV TC TYPE for its workflow.

Use the following table to determine which HDV TC TYPE is
utilized by a particular NLE:

720p 1080i
Avid GOP TC TTC
FCP TTC TTC
Edius TTC GOP TC or PTS

See your NLE users guide for more information.
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LCD CONTRAST

SET CONTRAST
VALUE: 00

Use this function to adjust the contrast of the LCD display for
easier viewing.

1. Use the Right navigation button to go to the SET CONTRAST
submenu.

2. Use the Up and Down navigation buttons to increase and decrease
the contrast number.

3. Press BACK when done.

FS-C Portable DTE Recorder 75



FS-C Functions

Functions Screen

The Functions buttons FA, FB, and FC provide convenient
Home screen shortcuts by acting as toggle switches for specific
system settings. The Home screen below is an example of the
information displayed.

N STOP 1-

COUNTER |
00:00:20:15
DISK 1 168 min

Reel receiving ——= R1
clips.

Function Keys

FA FB FC
Function Groups

Function settings are user-assignable and available in the
Functions screen. Changing a setting with a Function button
has the same effect as manually changing the setting.

FUNCTIONS

-FA SYNC
FAAV/C

FA TAPELESS
FA REELS

* There are three groups of functions FA, FB, and FC
displayed via the Functions screen.

* The function groups are independent of each other.

* Ineach group only one selection is active at a time.
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FS-C Functions

A list of the Function button menu is below. In each group, the
default selection is listed first.

MENU Appears on LCD as...

FA SYNC SYNC
Toggles between SYNCRO and LOCAL record control.

FA AV/C AV/C (Toggles between AV/C and LOCAL control)

FA Tapeless TAPE (Toggles between Tapeless TRIGGER and LOCAL control)
Default

FA REELS REEL Increments current reel number

FA RO-0 RO Marks Current Clip to Reel 0,

FAR1-1 R1 Marks Current Clip to Reel 1,

FA R2-2 R2 Marks Current Clip to Reel 2,

FA R3-3 R3 Marks Current Clip to Reel 3,

FA R4-4 R4 Marks Current Clip to Reel 4,

FA R5-5 R5 Marks Current Clip to Reel 5,

FA R6-6 R6 Marks Current Clip to Reel 6,

FA R7-7 R7 Marks Current Clip to Reel 7,

FA R8-8 R8 Marks Current Clip to Reel 8,

FA R9-9 R9 Marks Current Clip to Reel 9,

FA LCD ON/OFF LCD1/LCDO LCD On/Off Toggle

FA LCD AUTO LCDA/LCDO LCD Auto On/Off Toggle

FA BLANK No Function.

FB DISP DISP (Toggles the different TC display modes) (Default)

FB ALARM ALRM/MUTE Turns the FS-C alarm on or off.

FB FILE FILE (Toggles between normal and display of the file name)

FB REELS REEL Increments current reel number

FB R0O-0 RO Marks Current Clip to Reel 0,

FB R1-1 R1 Marks Current Clip to Reel 1,

FB R2-2 R2 Marks Current Clip to Reel 2,

MENU Appears on LCD as...

FB R3-3 R3 Marks Current Clip to Reel 3,

FB R4-4 R4 Marks Current Clip to Reel 4,

FB R5-5 R5 Marks Current Clip to Reel 5,

FB R6-6 R6 Marks Current Clip to Reel 6,

FB R7-7 R7 Marks Current Clip to Reel 7,

FB R8-8 R8 Marks Current Clip to Reel 8,

FB R9-9 R9 Marks Current Clip to Reel 9,
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FB BLANK No Function.

FC LOCK LOCK/UNLK Locks the buttonpad (Default) - toggles between
LOCK and UNLK <Unlock>

FC DV/DD DD Toggles FS-C between DV/HD and HDD Modes

FC REELS REEL Increments current reel number

FC RO-0 RO Marks Current Clip to Reel 0,

FC R1-1 R1 Marks Current Clip to Reel 1,

FC R2-2 R2 Marks Current Clip to Reel 2,

FCR3-3 R3 Marks Current Clip to Reel 3,

FC R4-4 R4 Marks Current Clip to Reel 4,

FC R5-5 R5 Marks Current Clip to Reel 5,

FC R6-6 R6 Marks Current Clip to Reel 6,

FC R7-7 R7 Marks Current Clip to Reel 7,

FC R8-8 R8 Marks Current Clip to Reel 8,

FC R9-9 R9 Marks Current Clip to Reel 9,

FC BLANK No Function.
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LOCK/UNLK:

UNLOCK KEYS

PRESS SELECT
TO CONFIRM

This function is a toggle switch that locks and unlocks the keys
on the FS-C’s front panel.

To prevent accidental unlocking of the front panel, there is an
unlock confirmation screen:

1. Press the UNLK key.
2. Press SELECT to unlock the front panel keys.
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Assigning Clips to Reels

COUNTER
00:00:20:15
DISK 1

168 min

Currently
Selected REEL
g
e REEL __ R2

Function FA
setto FA REELS

Function FB Function FC

set to FB R2-2 set to FC R1-1

The function buttons are a quick way to mark video clips
during recording. The Functions menu offers two types of
markers to use, as an example FA REELS and FB R2-2.

* FAREELS

Selecting the FA REELs programs the FS-C to mark the
clips to the currently selected reel. The current reel is
indicated in the line above the FA function reel
selection.

* FBR2-2

Setting a function button to this type of marker,
instructs the FS-C to mark the current clip as belonging
to the REEL R2.

Blank

Functions identified as Blank are inactive.
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Utilities Screen

UTILITIES

ORGANIZE REEL
ORGANIZE OMF

ORGANIZE MXF
ORGANIZE PINN

The Utilities available are:
« ORGANIZE REEL
«  ORGANIZE OMF
¢ ORGANIZE MXF 2.0 only
« ORGANIZE PINN
e DELETECLIP p
- FORMAT p

* REPAIRDISK p

e REPAIRCLIP p DV modeonly

- FILENAME p

- UPGRADE p

- SYSTEMRESET p
- DIAGNOSTIC p

. STATUS p
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@Niote

Organize Functions are Mutually Exclusive

Once one organize utility is performed on a set of files, another organize
function can not be applied. For example, if the Organize OMF is used on a
set of files, then Organize Reel can not be applied to them.

Organize Reel

This selection places all files identified as a REEL clip during
recording or playback into the appropriate reel folder. You can
import this folder directly into most DV NLE bins.

Organize OMF

When files are recorded in the AVID OMF file format, this
selection allows you to take all the OMF and AIF audio files at
the end of a recording session and place them into a folder on
the disk drive named OMFI MediaFiles. When the disk is
connected to a computer, this folder is recognized by Avid
Xpress DV's Media Tool enabling direct import of files into the
Avid timeline. Refer to the section, Using Avid OMF Clips
(Required for DV mode only) on page 41 for more information.

Organize MXF Fs-C 2.0 upgrade only

When using MXF OPAtom with some NLEs, such as AVID
Xpress Pro, it is necessary to do an Organize MXF prior to
importing the clips. Organize MXF is available in the Utilities
menu.
The Organize MXF:
* Moves all MXF video files into the
/contents /video directory.

e  Moves all MXF audio files into the
/contents /audio directory.

* Updates and moves the xml files from the log directory
into the /contents/clip directory.

* Generates thumbnails of the clips in the
/contents /icon directory.

82 FS-C Portable DTE Recorder



FS-C Functions

Organize PINN

This selection organizes clips for use with Pinnacle Liquid
series NLE systems. Products such as the Pinnacle file format
were created for use with products such as Pinnacle Liquid
Edition. The Pinnacle file format creates three files
simultaneously during a recording; an AVI video file and two
separate WAV audio files labeled as left and right. An
additional ALE file for each recording session is also created
which contains timecode data. This file must be kept with the
media.

Once clips have been imported into Liquid Edition, an Index
file is created on the disk drive for each clip. Do not delete this
tile since it is required to continue work in the particular
project.
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Delete Clip

DELETE CLIP
CLIP 001

YES BACK

Use this item to delete a selected clip.

1. From the Utilities screen, go to the DELETE CLIP screen.

2. Enter the number of the clip to be deleted using the Up and Down
navigation buttons.

3. Press the YES function key.
The selected clip is deleted.
4. Press BACK to return to the Utilities screen.

When a clip is deleted, the FS-C re-organizes and displays the
remaining clips in sequence. For instance, if there are three
clips on the disk: 1-001, 1-002, 1-003. If clip 1-002 is deleted, the
remaining clips are reorganized and clip 1-003 becomes clip 1-
002. However the base file names are not affected.

@iote

Use Delete Clip Sparingly

Using the delete clip can cause disk fragmentation that reduces disk drive
performance and can impact both Playback and Record. To defragment the
disk or if more disk space is needed:

e Transfer all content from the FS-C.
» Perform the FORMAT utility, see Format Disk on page 85.
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Format Disk

FORMAT DISK

PRESS YES TO
ERASE ALL DATA

YES BACK

Prevent lost frames due to file fragmentation by formatting the
FS-C before each recording session.

A Save Files Before Formatting

The formatting process erases all data on the disk and is not
reversible. Backup all files and clips on the FS-C before
formatting.

This selection formats the disk as follows:

1. From the Utilities screen, go to Format Disk.

2. Select YES to begin formatting.
A status screen displays progress of the formatting and at
completion displays the message:

* Complete indicating Repair Disk was successful.

* Aborted indicating that there were errors and the repair did
not complete.

3. Press BACK to return to the Utilities screen.
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Repair Disk

REPAIR DISK

PRESS YES TO
REPAIR DISK

YES BACK

Use this function if a recording session does not complete
properly and there is a question that the file may be damaged.
For example, recording terminates due to a loss of power to the
FS-C. Repair Disk scans the entire disk drive checking for and
repairing file errors and incomplete files. When the file is
repaired it is can be used in the NLE system.

@iote

Corrupted Files May Need More Repairs
After running Repair Disk some files may still need further work to restore
them. In such a case, run the utility Repair Clip, refer to the following page.

To repair a disk:

1. From the Utilities screen, go to Repair Disk.

2. Select YES and the FS-C begins repairing the disk.
A status screen displays the progress of disk repair and at
completion displays the message:

» Complete indicating Repair Disk was successful.

* Aborted indicating that there were errors and the repair did
not complete.

3. Press BACK to return to the Utilities screen.
4. Move content from FS-C.

5. Use Format Disk utility before doing any further recording. This
step optimizes disk storage, see Format Disk on page 85.
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Repair Clip DV Mode only

REPAIR CLIP

CLIP 001

YES BACK

Use this function to repair a specific file that may be damaged
or incomplete. For example, recording terminates due to a loss
of power to the FS-C and a specific file may be damaged.
Repair Clip scans the specified file checking for and repairing
tile errors and incomplete files. When the file is repaired it then
can be used in the NLE system.

1. From the Utilities screen, go to Repair Clip.

2. Enter the number of the clip to be repaired, using the Up and
Down navigation buttons.

3. Press YES and the FS-C begins repairing the file.
A status screen displays the progress of disk repair and at
completion displays the message:

* Complete indicating Repair Disk was successful.

* Aborted indicating that there were errors and the repair did
not complete.

4, Press BACK to return to the Utilities screen.
5. Move content from the FS-C.

6. Use Format Disk utility before doing any further recording. This
step optimizes disk storage, see Format Disk on page 85.
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FILE NAME
CLIP 001

20060101 -
165423

This function displays a file name but does not permit
changing it.
1. From the Utilities screen, go to FILE NAME.

2. Enter the file’s clip number using the Up and Down navigation
buttons.

The base filename is dynamically displayed as a function of the
clip number.

When a clip has multiple files, the first Base file name is displayed

3. Press BACK to return to the Utilities screen.
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Upgrade

Check Focus Enhancements website for upgrades and latest
software updates, go to www.focusinfo.com.

To upgrade system software:

1. Set the FS-C to DD Drive mode from the HDD Mode screen and
connect it to a computer.

2. On your computer, rename the XXX.bin file as fsc.bin.

3. Copy or drag the fsc.bin file to the FS-C while it is in DD Drive
mode.

4. Exit the FS-C from DD Drive mode and navigate to the Utilities
screen.

5. From the Utilities screen, go to Upgrade.

6. Press Right. The following screen appears.

UPGRADE

PRESS SELECT
TO UPGRADE

SOFTWARE

BACK

7. Press Select.

8. A confirmation screen apﬁears: press YES to continue.
A status screen displays the progress of the upgrade.

UPGRADE
UPGRADING ...
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9. Up on successful completion of the upgrade, the FS-C displays
the message:

UPGRADE
COMPLETE

PLEASE RESTART

10.Hold down the STOP / POWER OFF button until the FS-C shuts
down.

11. Power up the FS-C.

Upgrade Errors

If the upgrade fails, the FS-C displays one of the following
messages:

UPGRADE ERROR

WRONG PRODUCT
ID

Verify that the update is for the model of FS-C it is being installed
on. An update is not cross-platform and must be installed on the
model for which it is intended.

To find the specific model of a FS-C go to the SETUP screen
and then version (V 1.0.0), refer to Setup Screens on page 65.
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UPGRADE ERROR

FILE
NOT FOUND

Verify that the upgrade file name is fsc.bin and that it is in
the FS-C hard drive’s root directory.

System Reset

SYSTEM RESET

CONTINUE TO
RESET

SYSTEM?
YES BACK

The System Reset feature restores the factory default settings
for the FS-C unit. This feature is useful for diagnosing
problems with the unit.

A System Reset

A System Reset can not be reversed.
Diagnostic

A DO NOT CHANGE THE SETTINGS OF THIS FUNCTION

This function is included to assist Focus Enhancement
Technical Support diagnose problems that may occur with the
FS-C.
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Status

The FS-C Status screen provides details of the systems power
state as well as internal temperature. This screen may assist
Focus Enhancements Technical Support in determining power
and thermal problems with your unit.
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Reels Screen

When a disk is formatted, the FS-C creates 10 folders,
numbered 0-9, on the disk. During recording or playback of a
clip, it is possible to place it into folders or play it from up to 10
different reels.

These folders can have any name up to 10 characters in length.
To name the folders it is first necessary to enter DD Drive mode
and mount the FS-C to a computer.

Placing a Clip in a Reel

From the Reels screen, choose the Reels as follows:

1. From the Utilities screen, go to Reels screen.
Values include:
¢ FA RO-0 Default Value

e FA RO-0 through R9-9 “Reel Name”

2. Select a reel from the list.

When selecting a REEL from this screen, the current track is
marked with that REEL number. This can be done in any mode:
record, stop, or playback.
Each of the function keys can be set to specific reel, making it
possible to quickly switch between multiple reels: a total of
three reels being the maximum. Refer to Functions Screen on
page 76 for more information.
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Using a Wired Remote Control

When using the optional wired remote control, use the button
pad numbered 0-9 to mark the clips. Any additional button
presses during a recording or playback, changes the selected
REEL. Once a session is finished, select ORGANIZE REEL in
Utilities screen. The marked clips are placed in the REEL in
sequential order.

When a reel is selected, the Home screen menu displays the
reel’s name on the left side of the second to the last line of the
screen, refer to LOCAL on page 97.

@Note

Optional Wired Remote Control (p/n ACSS-0019-01)
To order the Wired Remote Control, go to Focus Enhancements website,
www.focusinfo.com/sales/store/.
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Play Screen

PLAY

PLAY CLIP
LOOP CLIP

LOOP ALL
PLAY ALL

« Play Clip
In this mode, the FS-C plays the selected clip from start

to finish when you press the PLAY button. At the end
of the particular clip, the FS-C pauses.

« Loop Clip
In this mode, the FS-C plays the selected clip from start
to finish. Immediately after completing the clip, the FS-

C begins playing the clip again without a pause. It stays
in this state until stopped.

e Loop All

In this mode, the FS-C plays the entire contents of the
disk (all clips), in order, from start to finish. At the end
of the last clip, the FS-C begins to play from the
beginning of the first clip again without a pause. It stays
in this state until stopped.

« Play All

In this mode, the FS-C plays the entire contents of the
disk (all clips) in order, from start to finish. At the end
of the last clip, the FS-C pauses.
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Play From Screen

PLAY FROM

TRACK LIST
REEL LIST

This screen permits the selection of from where clips playback.
There are two choices:

e Track List

Clips playback in the order in which they were
recorded. Playback order is based on the order of the
file names.

* Reel List

Clips in a selected folder are played back. This function
provides the ability to choose between any folders on
the disk. Folders can appear with their user assigned
folder name (if used).
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Control Screen

-SYNCRO SLAVE
AV/C

TAPELESS

The Control screen provides the capability of enabling the FS-C
to operate in five different control modes during record and
playback.

« LOCAL

Local control mode ignores record triggers from the
camcorder and is controlled exclusively from the FS-C
front panel or the optional wired remote control unit.

Transport
Keys

Keeper
(cycles through
Reels)

1-
COUNTER
0-9 REEL 00:00:00:00:
numbers DISK 1 000 min

R1
SYNC DISP LOCK

* Transport keys have the same functions as on the FS-C.
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* Usethe Keeper ¢ key to cycle through the available
Reels. For example, if the current Reel selection is 3.
pressing Keeper changes the selection to Reel 4.

To purchase the wired remote control, p/n ACSS-0019-

01, for the FS-C, visit Focus Enhancements web site at

www.focusinfo.com/sales/store/.

Syncro Slave

Use this mode when the camcorder does not have FS-C
compatible external control or the tapeless trigger
functionality. In Syncro Slave control mode, the

FS-C mimics the camcorder’s operations by monitoring
the camcorder’s tape record state.

AVIC
@Note

Do Not Use AV/C control in Record Mode

Use AV/C in playback mode and other situations
where the FS-C is controlled by an external FireWire
device such as a NLE system that is not supported by
Direct To Edit Technology. In these cases, the FS-C can
be used in a manner similar to a camcorder to capture
footage to the NLE. When in HD RECORDER mode, and
the QUICKTIME HD FORMAT is selected, the type of
timecode reported is defined by the HDV TC TYPE setting,
refer to HDV TC TYPE on page 74.

Tapeless

The Tapeless Control mode allows the FS-C to be
controlled from a camcorder, if it features a FS-C
compatible external control setting separate from the
tape transport. Use Tapeless Control mode with the
companion Canon HDV camcorder.

@iote

Camcorder Requirements for Tapeless Control Mode

Tapeless Control mode will not work unless it is supported by the
camcorder and the camcorder is placed in this external control mode.
Please check your camcorder manual for more details.
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LCD Display Symbols and Text

The table below shows the different symbols and states displayed on
the top line of the LCD when used with different FS-C control,
record, play and stop modes:

PLAY/REC MODE FS-CLCD
Stop STOP
Pause Il PLAY
Play P PLAY
Rec (Pause) Il REC
Normal Rec (Rec) REC
Retro Disk (Stop) L STOP
Retro Disk (Standby) L REC
Retro Cache (Stop) C STOP
Retro Cache (Standby) C REC
Loop Record (Stop) O STOP
Loop Record (Rec) O REC
Loop Record (Standby) Il OREC
Snap (Stop) STOP
Snap (Standby) Il SNAP
Snap (Rec) Il SNAP
Time Lapse (Stop) STOP
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PLAY/REC MODE FS-C LCD

Time Lapse (Pause) I TREC

Time Lapse (Rec) O TREC

AV/C* (Stop) A STOP

AV/C* (Rec Pause) II' A<REC TYPE>REC
AV/C* (Rec) A<REC TYPE>REC
AV/C* (Play Pause) Il A PLAY

AV/C* (Play) A PLAY

Syncro Slave (Pause) II' YXREC TYPE>REC
Syncro Slave (Rec) Y<REC TYPE>REC
Tapeless (Pause) Il EKREC TYPE>REC
Tapeless (Rec) E<REC TYPE>REC

AV/C* Only for use when the FS-C is connected to a computer system.
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Technical Specifications

Specifications are subject to change.

Physical Description

e Dimensions:; 1.59" x 5.6" x 3.74" (40mm x 142mm x 95mm)
(with normal 90 minute Battery)

¢ Weight: 1 Ib. (.45 kg)

Input/Outputs

* DV Video I/O - 25Mb/s (1x 6-pin IEEE-1394)
In HD RECORDER mode the unit accepts 720P and 1080i
MPEG video from specially equipped camcorders.

e FireWire Computer I/F - up to 400Mb/s (1 x 6-pin IEEE-
1394)

eGPl & RS-232C Control (1 x 3.5mm mini jack)

Power
15V DC, 7.5W
e Mini-jack power connector

e Custom Removable Li-ion Rechargeable Battery Pack (90
minutes estimated run-time)

Audio/Video/Timecode Specification

*  25Mbl/s, 8-bit 4:1:1 (NTSC-DV) or 4:2:0 (PAL-DV) video
(model dependent). The HD RECORDER mode supports
720p (24/25/30) and 1080i (50/60) from HDV camcorders
with a 1394 interface.
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* DV Embedded Timecode (Drop or Non-Drop)

e DV audio: embedded 2-channel (16-bit, 48kHz) or 2-channel
(12-bit, 32kHz) Audio. 4-channel (12-bit, 32kHz) is available
for RawDV format only.

e HD audio: MPEG1 Audio Layer II.

DTE File Formats

* DV mode: Raw DV, AVI Type 1, AVI Type 2, Matrox AVI,
Canopus AVI, QuickTime, AVID OMF, AVI Type 2 24p
(NTSC only), QuickTime 24p (NTsc only), Pinnacle

HD mode: M2T

* FS-C2.0upgrade only
MXF OPAtom (DV)
QUICKTIME (HD)

Disk Information

* Internal Disk Type: 5400RPM, 8 MB cache
See www.focusinfo.com for available hard drive capacities.

e Disk Format: FAT32

* FS-C compatible with Windows 98SE, ME, 2000, XP and
Mac 0S9/10.

Log Files

With each recording of a particular clip on a disk, the FS-C creates a
text log file to identify information about the recorded clip and the
recording session. Information includes:

e Clip name

» Clip in/out source TC values
» Clip duration

» Clip type (record file type).

The log file also identifies when the shock cache becomes low and
when disk or other errors occur during a recording.
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Error Messages

Error messages may appear on the FS-C LCD display from time to
time. The purpose of these messages is to alert you to action that may
effect your FS-C operation. Below is a list of error messages and
actions you can take:

Error Message

Description

Action

LOW BATTERY!

Battery power is low.

Connect AC Power or replace the bat-
tery pack. When the unit is run without
the battery installed, this warning can
be displayed, that is normal.

HIGH
TEMPERATURE!

The unit is getting too hot
for normal operation.

Make sure the vent and fan intake
holes are clear.

NO SPACE LEFT!

The Disk Drive is Full.

Transfer files off the drive and format it

before attempting to do more record-

ing.
DISK ERROR Lost Disk Communication. Contact Focus Enhancements Techni-
XXX cal Support.
NO DISK Lost Disk Communication. Contact Focus Enhancements Techni-
DETECTED cal Support.
WRONG Incorrect Software Loaded. Download correct software and per-
PRODUCT ID form upgrade again.

FILE NOT FOUND Wrong filename or missing

file.

Check filename or that upgrade file
exists.

TRK LIMIT MAX! 999 clips exist on system. Copy content from FS-C hard drive

and re-format.

Warranty
e 2years, FS-C
* 90 Days Accessories including the battery.

Temperature
e Operating: 0-40° C (32 - 104°F)
e Operating humidity: 30% to 90% RH
»  Storage temperatures: -20 to 60° C (-4° to 140°F)
e Storage humidity: 85% RH or less
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Compatible Camcorders and Accessories

For a list of tested camcorders, refer to www.focusinfo.com.
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